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1 Safety guidelines

Programmable logic controllers (PLCs), operating/monitoring devices (industrial PCs, HMI) have
been designed, developed and manufactured for conventional use in industrial environments. They
were not designed, developed and manufactured for any use involving serious risks or hazards that
could lead to death, injury, serious physical damage or loss of any kind without the implementation
of exceptionally stringent safety precautions. In particular, such risks and hazards include the use of
these devices to monitor nuclear reactions in nuclear power plants, their use in flight control or flight
safety systems as well as in the control of mass transportation systems, medical life support systems
or weapons systems.

1.1 Policies and procedures

Electronic devices are never completely failsafe. If the programmable control system, operating/
monitoring device or power supply fails, the user is responsible for ensuring that other connected
devices, e.g. motors, are brought to a secure state.

When using programmable logic controllers or operating/monitoring devices as control systems
together with a soft PLC, safety precautions relevant to industrial control systems must be observed
in accordance with applicable national and international regulations. The same applies for all other
devices connected to the system, such as drives.

All tasks such as the installation, commissioning and servicing of devices are only permitted to be
carried out by qualified personnel. Qualified personnel are those familiar with the transport, mounting,
installation, commissioning and operation of devices who also have the appropriate qualifications
(e.g. IEC 60364). National accident prevention regulations must be observed.

The safety notices, information on connection conditions (type plate and documentation) and limit
values specified in the technical data are to be read carefully before installation and commissioning
and must always be observed.

1.2  Installation guidelines

« These devices are not ready for use upon delivery and must be installed and wired according to the
specifications in this documentation in order for the EMC limit values to apply.

- Installation must be performed according to this documentation using suitable equipment and
tools.

+ Devices are only permitted to be installed by qualified personnel without voltage applied. Before
installation, voltage to the control cabinet must be switched off and prevented from being switched
on again.

+ General safety guidelines and national accident prevention regulations must be observed.

+ Electrical installation must be carried out in accordance with applicable guidelines (e.g. line cross
sections, fuses, protective ground connections).

1.3  Viruses and dangerous programs

This system is subject to potential risk each time data is exchanged or software is installed from a data
medium (e.g. diskette, CD-ROM, USB flash drive, etc.), a network connection or the Internet. The user is
responsible for assessing these dangers, implementing preventive measures such as virus protection
programs, firewalls, etc. and making sure that software is only obtained from trusted sources.

14  Organization of safety notices
Safety notices in this manual are organized as follows:

Safety notice Description
[Danger!] Disregarding these safety guidelines and notices can be life-threatening.
: Disregarding these safety guidelines and notices can result in severe injury or
|
substantial damage to property.
Disregarding these safety guidelines and notices can result in injury or damage to
: property.

This information is important for preventing errors.

User manual - HMI Series - 5



2 TdControlPanel

The TdControlPanel utility is the main interface for configuring the operator panel’s main ports and
services. This interface can be accessed by holding down the “STOP” icon that appears when the panel
is started, or from the “TdControlPanel” button visible in the movicon project, which starts automatically
if the panel is brand new.

When the TdControlPanel is launched from the “STOP” icon, all system services are interrupted (i.e.
LogicLab, Movicon, VNG, PixsysPortal are not running and will not respond to any requests to access/
download code).

At switch-on a project starts allowing to verify the machine
general status, date/system hour, related IP address,
SoftPLC execution in background.

Using a VNC client you can view from your PC what is displayed on the PLC / HMI. Starting a browser
with active Java service it is possibile to test if the device Webserver function is active. For this function
it is necessary to use Internet Explorer.

Press “Td Control Panel,” to access the device control
panel and verify/configure all the services and projects
to be launched at starting. It is possible also to configure
the standby time for the backlighting switch off and the
buzzer at display pressure.

The following paragraphs describe each function of the TdControlPanel windows.
NB: Pictures show device standard configuration.

2.a WIN EXPLORER

From this window it is possible to choose a set of options

to start Windows CE and execute TDControlPanel.

« The first option starts Windows CE with desktop.

« The second option allows TDControlPanel starting if ,
during the switch on , the key “Stop” is keep pressed @.

« Enabling the third option it is possible to set a
protection password to avoid that unauthorized users,
keeping pressed “STOP” @, access TDControlPanel
settings.

“START WINDOWS DESKTOP” allows to start “Explorer.exe” to access Windows CE desktop.
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2.b HMI_MOVICON

From this window, it is possible to select which services
and programmes related to Movicon 11 are to be executed
automatically when the device is started up.

Movicon scada functions are available in all HMIs and
in the PL500 in the “WEB” version (PL500-335-1AD-
WEB)

The “Run Project at STARTUP” flag starts the Movicon project indicated hereover at panel start-up.
The “Run File Service at STARTUP” flag starts the connection service with the Movicon development
environment at panel start-up.

The “WATCHDOG" flag enables the function that restarts the project if the Movicon runtime closes
accidentally.

The “Delay at START in seconds” field inserts a delay, after the panel has started up, for the Movicon
project to start, to give any PLC time to start up and be available on the network.

“SAVE” button saves the modifications and closes the window.

“SAVE and START” button activates manually the Movicon project (and the file upload service)

2.c PLCLOGICLAB

From this window it is possible to enable/disable the
SoftPLC execution at starting. Selecting “RUN console
DEBUG”, during the SoftPLC execution, the Debug window
will be filled with real-time system events to verify possible
anomalies.

NB: this function requires many device resources. It is
suggested to keep it active only if there are problems
during the software development. Disable this function at
the end of the development phase.

“START” button activates manually the SoftPLC project (and any debug window).

2.d LAN ETH1

From this window, the parameters of the device’s Ethernet
port 1 can be changed.

Enabling the “DHCP Enabled” flag configures the port in
DHCP mode, otherwise all IP parameters must be entered
manually in the fields available below.

Enabling the “Bridge” flag configures the two ETH1 and
ETH2 ports in “switch” mode, realising a daisy-chain (or
cascade) connection of several devices without using
external Ethernet switches.

Disabling the “Bridge” flag will require each Ethernet port to be configured with its own IP address,
resulting in two completely isolated networks.
NB: The default IP address of the operator panels is 192.168.0.100 and “Bridge” mode is enabled.
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2.e LAN ETH2

2.f BACKLIGHT - BUZZER

From this window, it is possible to change the parameters
of the device’s Ethernet port 2 if it is available and if the
‘switch’ mode on the LAN ETH1 board hasn’t been enabled.
In the case of panels with only one Ethernet port, it is
possible to obtain a second Ethernet port by connecting
the USB-Ethernet converter with our code 2400.70.005 to
the USB port.

Enabling the “DHCP Enabled” flag configures the port in
DHCP mode, otherwise all IP parameters must be entered
manually in the fields available below.

From this window it is possible to configure backlighting
and buzzer parameters. Enabling “Always ON” the
backlighting keeps always active. Otherwise, enter time
value in seconds on “Backlight ON for..(sec)” to enable the
switching off or the lamp attenuation.

The first two fields allows to select the lamp brightness
percentage (100% = ON, 0%=O0FF) during standard
operation or standby.

“Buzzer frequency” allows to select the buzzer tone
frequency (an higher frequency corresponds to a more
acute tone). Select “Buzzer OFF” to deactivate the buzzer at
touch.

“TEST” keys allow to test selected parameters before saving the configuration.

2.9  WINVNC

Enabling the “RUN VNC at STARTUP” flag configures the
operator panel to automatically start the VNC server
service each time it is switched on.

Enabling the “DAILY RESTART AT HOURS (0..23)" flag
configures a time of day when the service is automatically
restarted.

The “START VNC” button starts the service manually.

The “KILL VNC” button terminates the service manually.
The “START CONFIG” button opens the VNC configuration
window in order to set the authentication system, change
the access password, etc.

Attention the changing the parameters is recommended for advanced users, tampering with the
parameters incorrectly will cause the remote desktop service to malfunction.
Access to the VNC server uses port 5900 and is anonymous by default.

2.h VPN
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From this window you can access the configuration
interface of the PixsysPortal VPN service, as well as start or
manually terminate it.

Enabling the “RUN VPN at STARTUP” flag configures the
operator panel to automatically start the PixsysPortal
service each time it is switched on.

“Start VPN" starts the service manually (if not already
started), “KILL VPN” terminates the service manually (if
running).



For more information on the configuration and requirements of the service, please refer to the
documentation available on the dedicated page of our website
https://www.pixsys.net/convertitori-gateway/gateway-vpn/pixsys-portal

2. MQTT
From this window it is possible to configure the MQTT
functions available in the operator panels with integrated
SoftPLC. The service is a “ModbusTCP master --> MQTT
client” which retrieves data from the LogicLab status
variables and publishes them as MQTT client to the server
set up.
Enabling the “Enable MQTT CLIENT” flag activates the service
when the operator panel is started.
In the “BROKER” field the IP address of the MQTT server on
which the panel will publish the topics must be entered
(leave port 443).

In the fields “USER” and “PASS” the credentials for connecting to the MQTT server must be entered.

The field “Client ID” configures the published topics with the following syntax “USER/Client ID”",

leaving %MAC the Client ID will be the MAC address of the operator panel.

Pressing “SAVE” applies the configuration made.

Pressing the arrow button takes you to the second page, described below.

NB: All options not described are in the development phase and are not yet available.
The “IP SERVER Modbus_TCP” field must be filled in with
the IP address of the ModbusTCP slave device that the
service will interrogate to retrieve the data to be published;
leaving 127.0.01 means the device itself, regardless of its
network configuration (always leave port 502).
The fields “n° INT16, INT32, FLO32 MB_TCP” indicate how
many registers will be interrogated on the ModbusTCP side
(and therefore published on the MQTT side) starting from
the indicated “ADDR” field.

The “DSec” fields indicate the publication times of topics, expressed in tenths of a second. If left at 0,

publication only takes place on a change in the source data.

For example, by setting “n® INT16 MB_TCP” to “2”, “ADDR” to “10010” and “DSec” to “10", registers

10010 and 10011 will be interrogated by the ModbusTCP slave device and published every second.

NB: All options not described are under development and not yet available.

2j FTP

From this window, the FTP and TELNET functions of the
device can be configured.

The fields “FTP Enabled” and “TELNET Enabled” activate the
integrated FTP server and TELNET services respectively.
The fields “Anonymous Access” enable anonymous access for
the respective service. If one of the two ticks indicated is
disabled, access to the respective service is permitted with
the credentials set in the fields below (maximum 2 users).

NB: by default, both services are active and do not require credentials for access (anonymous
access).
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2.k BACKUP-RESTORE
BACKUP of LogicLab and Movicon projects stored on HMI.

After downloading LogicLab and Movicon projects on HMI
and after setting the HMI for their automatic execution at
each starting, switch off the HMI and restart it keeping the
STOP icon pressed.

TDControlPanel window will be opened

Insert a USB pen (FAT32 formatted) in one of the available
USB ports.

Press BACKUP-RESTORE to access the utility for projects
backup and device configuration

This window allows to select backup options:

PLC_LOGICLAB (RUNTIME PROJECT): for backup of LogicLab project and complete Runtime and
also of the configuration completed in the window PLC_LOGICLAB (accessible from main window
of TDControlPanel)

HMI_MOVICON (PROJECT): for backup of single Movicon project and configuration completed in
the window HMI_MOVICON (accessible from main window of TdControlPanel)

HMI_MOVICON (RUNTIME): backup only for Runtime

TdControlPanel (Configuration): for backup of complete configuration performed within different
utilities accessible from main window of TdControlPanel. *Attention: this backup will include also
the eventual Password for TdControl Panel if it has been set in WIN EXPLORER

LAN (IP CONFIGURATION): for backup of network settings of HMI

BOOT SCREEN: for backup of background image visualized during system start up

Tick all boxes to obtain a complete backup of the settings and software projects stored on the HMI.
This is useful and time-saving when requested to program multiple HMIs for same application.

Press BACKUP TO USB DISK to open USB memory
connected to the device; it will be possible to select
destination folder and name for backup file 8default file
name will be date and time of backup creation)
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Press OK to start backup (Hourglass will show up ).

A confirmation popup will advice when process will be
completed. Press OK to close popup, press ESC, then the
device may be switched off.

RESTORE procedure to restore LogicLab and Movicon projects on HMI.

To program a new HMI starting from an existing Backup
keep pressing STOP icon during start up of the device

TDControlPanel window will be opened

Insert the USB pen containg Backup files on one of the
available USB ports.
Press BACKUP-RESTORE

Press RESTORE FROM USB DISK to open USB memory
connected to the HMI and select the chosen backup file

Press OK to start Restore process (Hourglass will show up).
A confirmation popup will advice when process will be
completed. Press OK to close popup, press ESC, then the
device may be switched off.

From now on at each start the HMI will start the projects (and eventually the complete configuration
if selected ) automatically.
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3 LogicLab Suite (only HMI+SoftPLC)

LogicLab Suite is the Pixsys development environment for the programming of PLC series, PL500 and
all Operator panels / PanelPC.

The suite is available for free download within “download area” of the website pixsys.net, no activation
code is required (only registration). Supported by all 32/64bit Windows versions, starting from
Windows XP SP3. Available both in English and Italian version. Once downloaded the setup file on
the computer, start the installation and follow the standard procedure. The program can be activated
through the icon "LogicLab” @ (on desktop) or from the menu “Start” > “PixsysSuite” > “LogicLab”.

3.a Language modification

To modify the visualization language it is
necessary to open options window form the
menu “File” > “Options”, go to “Language”, select
“ITA - italiano” and press “Select”. Confirm with
“OK”, close and re-open LogicLab to enable
the modification.

3.b Create - load a project

Open an exsisting project:

« With LogicLab opened, click on “Open
project” or select one of the last projects
form the list.

«  With LogicLab closed, enter on the project
folder and select (double click) the chosen
file (icon @ and extension “.plcprj”).

Create a new project:

Press “New project”.

Enter the name of the new project and select
the folder where the project files will be stored.
Finally, select the device to be programmed.

Attention: selecting “respect capital/lowercase letters”, a variable which contains a capital letter
will be understood as different from another with the same name but with this letter lowercase. It
is recommended to keep this selection disabled, to avoid any confusion during the drafting of the
program code.

3.c Connection to target

Here below please find the necessary requirements for the correct connection between target (device
to be programmed) and the development environment on PC (LogicLab).

Target requirements:

+ device ON and started
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« configured with static IP address compatible with the network where there is the PC to which it will
connect. By default, the IP address of the HMI is 192.168.0.100, for PL500 is 192.168.0.99, so the PC
must have the same network and class (in this case 192.168.0.XXX) but different physical address
(the last 3 digits of the IP address, with a number between 1 and 255, different from 100). If it is
necessary to modify the IP address of the terminal, refer to the TD Control Panel configuration,
section “LAN ETH1" on par. 2.d.

« connection with net cable (direct or cross) directly to PC or through a net switch

« SoftPLC in execution (refer to TD Control Panel configuration, section “PLC LOGICLAB” on par. 2.c).

PC requirements:

« IP address compatible with the network where it is located and with the IP address configured on
the target (see previous points)

+ antivirus/firewall which allows the connection to network devices (normally already correctly
configured)

+ LogicLab configured for the connection to the target to be programmed: menu “On Line” > “Select
communication” , on the window that opens press “Properties” and than enter the target IP on “IP
Address”, keeping all the rest unaltered. In case of very slow networks or of a network configuration
with different switches, it is possibile to increase the “Timeout” value (expressed in mS).

The image represents default configuration

Confirm all windows pressing “OK” and save through  or from the menu “file” > “SaveProject”.

To verify the correct LogicLab and Target configurations, it is possible to make the connection pressing
¥ or form the menu “On Line” > “Connect”. If the connection is correctly done, the status bar at the
lower right side will visualize “CONNECTED” and “NO CODE” (to indicate that the target is connected
and has no code in it) or “DIFF CODE” (to indicate that the code which is being visualized does not
correspond to those who lies in the target).

3d Compiling and downloading the code

Once entered the project code it is necessary to verify eventual errors pressing F7, clicking on icon &
or from the menu “Project” > “Fill”.

If the compilation is correctly done it is possible to transfer the program to the target pressing F5,
throughicon  or from the menu “On Line” > “Code transferring”.

The status bar will show “CONNECTED” and “SOURCE OK” indicating that the program running on the
target corresponds to that which is visualized on PC.

3.e Watch window

If the program running on the target corresponds to that which is being visualized on PC, the status
bar will show “CONNECTED” and “SOURCE OK” and it is possible to use the window “Watch” to verify
real-time the status of the variables used in the project. To enable the window “Watch”, press CTRL+T
or use “View"” > “View tool window"” > “Watch”. To add a variable to the window “Watch”, just drag it inside
or press theicon  and select it manually.
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From now on, the window “Watch” will visualize
the value of the inserted variable, in real time.

Through it is possible to save, load and add an exsisting watch-list to the list of variables.

To change the visualization format, it is
necessary to select the variable and press &.
On the window that opens, select the chosen
format and confirm pressing “OK”.

4 Interfacing Movicon 11 and LogicLab (only HMI+SoftPLC)

NB: Movicon 11.5 or greater.

To execute only once:

Following steps are to be completed on the PC which will be used to develop the projects.

Go to download area of Pixsys website / Movicon section and download “MOVICON 11.6 Update-Ag-
giorna Driver.exe” corresponding to your PC system. Double click to launch the .exe file and follow
instructions.

Do the same procedure also if a Panel PC (TD750-TD850-TD900-TD910-TD920) is used.

Note: with this procedure all PLC system variables and variables created and used in the PLC are
imported.

The creation and the updating of the PLC variables list is done only if the LogicLab program is
compiled without errors and downloaded on the target.

4.a Creating a new Movicon project

Start the software and choose the platform “Windows® X86 / X64" for Panel-PC or “Windows® CE
Platform” for HMI and for “WEB” version of PL500. If the new Movicon project is being created following
the Wizard, at the end it will visualize the driver configuration window, switch to the section “Driver
Configuration” to par. 4.b. If the driver is being installed manually, proceed as follow:

Add the communication driver with a
right click on “Real time DB” and then “new
communication driver”.
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Select “Pixsys” from the manufacturer menu
and then “Pixsys SoftPLC Driver”.

Confirm with “OK” and double click on the
driver just created to open the configuration
window.

4.b Driver configuration

Select “Station” and add a new station pressing
“ADD".

1. Enter the path to the PLC symbol file,
located in the “Build” sub-folder of the folder
containing the LogicLab project files. The
file has the extension .SYM.XML and allows
you to import the PLC variables inside the
Movicon project.

4.

. This field is self-compiling after entering path as described on previous point. If using an HMI/PL500,

do not modify the self-compiling field; if using a Panel PC (TD750, TD850 etc...) enter the path used
for download of the LogicLab project (default D:\LLExec\ NameMyProjectLogicLab.sym.xml).

. If Movicon project will be executed on the HMI/PC where the softPLC is also installed, then the IP

address will be 127.0.0.1. If it will be executed on a different HMI/PC, then enter the IP address of the
softPLC. This also allows you to run, in preview mode, the Movicon project on your development
PC, including verification of communication with the SoftPLC. For this function, it is necessary
to indicate the IP address of the terminal being programmed (only at the end of development
should you enter the localhost address 127.0.0.1 so that the Movicon runtime residing in the panel
communicates with the SoftPLC running on the same machine).

From the section “General” assign a name to the station, ex. “PLC".

Press OK to save settings and exit.

Now it is possible to import the LogicLab
project variabiles on Movicon.

Right click on “SoftPLC Pixsys” and select “Import
PLC database”.
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Press “Read from PLC project”, the list of all
available variables will be provided.

Select variables to be imported and press
“Import”.

NB: If importing an array variable, it will be visualized as a structure carrying the array name.

Single array members will be accessible individually with following syntax NameMyArray:NameMyArray
_Xwhere Xis the array index (starting from 0).

Now variables are available on the Movicon project. If it is necessary to import new variables (to modify
LogicLab project), repeat only the reading and import variables procedure.

4.c Downloading the Movicon code to the target
To downlaod the Movicon Project, use the icon:
1. Select the transferring protocol: TCP
2. Insert the target IP address (default for HMI/PLC:
192.168.0.100).
3. If using an HMI/PLC leave the field blank, if using
a Panel-PC insert user (or the user name that is
logged on the Panel-PC target).
4. If using an HMI/PLC leave the field blank, if using
a Panel-PC insert 123456
5. If using an HMI/PLC insert \NandFlash\MyMovi-
conProjectName\, if using a Panel-PC insert D:\
MyMoviconProjectName\. In this way Movicon will
create a folder named MyMoviconProjectName
and it will download all the project files into it.
NB: it is important that the start of the path indicated
is \NandFlash\ (followed by the name of the
subdirectory that will be created), otherwise the
project files will be transferred to RAM and will
therefore be lost when the panel is switched off!
6. Press “Upload Project!” to download the project files to the target (press “Yes to All" if a project was
already downloaded to overwrite the old files).
7. Once the download is completed, press “Start Deviec Project” to launch the execution of the project
in the target (the project in execution will be closed and the new one will be executed)
NB: if you need to trasfer different projects/versions to the target, you can change the destination
folder (you must mantain the first part of the address \NandFlash\).
Using the TdControlPanel is possible to select which Movicon 11 project will be executed automatically
at starting (see paragraph 170.b).
NB2: The “Delete Device Memory Card” button allows you to delete the folder indicated in the “Device
Folder” field, clearing the panel of project files contained in it. It is important to remember that if no
folder is indicated under \NandFlash\ this button will delete all the files residing in the \NandFlash\
itself, rendering the panel unusable!
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5 Simulation of the whole project SoftPLC + SCADA (only
HMI+SoftPLC)

From LogicLab, launch the simulator through the icon = or from menu “Debug” > “Simulation mode”.
On the window which appears, create a new working area indicating the name and the destination
folder (by default it is selected the folder where the project resides).

At this point, the simulator will be activated and connected (status window shows “CONNECTED") but
without the code (status window shows “NO CODE”), transfer the code pressing F5, through the icon

or from the menu “Online” > “Online download code”.

Verify that the status bar visualize”CONNECTED” and “SOURCE OK”. If “NO CODE is still visualized, restart
the simulator pressing % or from the menu “On-line” > “Target reboot”.

On Movicon, entering the Pixsys driver configurator and configure as follows:

1. Enter the folder where the LogicLab

project resides (subdir “Build”) and

select the file NameMyProjectLogicLab.

sym.xml

. Enter the folder where the simulator is

operating, set as filter “All files (**) and

select the file NameMyProjectLogicLab.

sym.simul. Pay attention to the file

exstension, into the project folder there

are many files with the same name but

different extension.

. Select the localhost address: 127.0.0.1

. From the section “General” assign a
name to the station, ex. “PLC".

At this point, to start the simulation of the graphic interface connected to the simulator (which is
already executing the code previously downloaded), press Alt+F12, theicon  or from the menu “File”
> “Start Project”.

To end the simulation, press Alt+F12 or theicon  on the bar which appears on the upper side.
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Warranty terms

Pixsys srl warrants its electronic devices for 12 months from Invoice date. Pixsys liability shall be limited
to repairing (or replacing at its option) any defective product which is returned with RMA (Return
Material Authorization) priorly obtained on Pixsys website and to be clearly marked on documents.
Pixsys shall not be responsible for accident, neglect, misuse, damage to objects or people caused
using the devices outside their specifications or outside any published performance data, including
unauthorized and unqualified repairing or failure to provide proper environmental conditions. In no
event shall Pixsys liability exceed the purchase price of the product(s).

Warranty does not cover any damage arising from post-sale installation of software applications and
specifically any damage caused by malware. Technical assistance by Pixsys which should be required
to restore OS will be subject to assistance fee prevailing at time of request.

Notes / Updates
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1 Norme di sicurezza

Le indicazioni di questo manuale sono riferite a prodotti Pixsys quali i dispositivi logici programmabili
(PLC) e i dispositivi di controllo e monitoraggio (PC industriali, HMI) da ora in poi identificati
semplicemente con il termine “Il dispositivo” o “i dispositivi”. | dispositivi realizzati e commercializzati
da Pixsys sono progettati, sviluppati e realizzati per un uso convenzionale in ambienti industriali. Non
sono stati progettati, sviluppati e realizzati per qualsiasi altro uso che possa comportare gravi rischi
o pericoli quali decesso, lesioni, gravi danni fisici senza che siano adottati rigorosi sistemi di sicurezza
indipendenti dal dispositivo. In particolare, tali rischi e pericoli includono I'uso di questi dispositivi per
monitorare le reazioni nucleari nelle centrali, il loro uso nei sistemi di controllo o sicurezza del volo,
nonché nel controllo di sistemi di trasporto di massa, supporto a sistemi salvavita medicali o sistemi
d'armamento.

1.1 Regolamenti e procedure

| dispositivi elettronici non sono mai completamente sicuri. Se il dispositivo viene meno al suo
funzionamento, l'utente é responsabile di garantire che altri dispositivi connessi, ad es. motori,
siano portati in una condizione di sicurezza. Le precauzioni di sicurezza inerenti i sistemi di controllo
industriale devono essere adottate in conformita alle normative nazionali e internazionali applicabili
quando si utilizzano i dispositivi come sistemi di controllo insieme a Soft-PLC. Lo stesso vale per tutti
gli altri dispositivi collegati al sistema. Tutte le operazioni come l'installazione, la messa in servizio e la
manutenzione dei dispositivi devono essere eseguite solo da personale qualificato.

Il personale qualificato deve avere familiarita con il trasporto, montaggio, installazione, messa in
servizio e funzionamento dei dispositivi ed avere le previste qualifiche ad operare (ad esempio IEC
60364). E necessario osservare le norme nazionali sulla prevenzione degli incidenti.

Le avvertenze di sicurezza, le informazioni sulle condizioni di collegamento (etichette e documenta-
zione) e i valori limite specificati nei dati tecnici devono essere letti attentamente prima dell'installa-
zione e della messa in servizio e devono essere sempre osservati.

1.2 Linee guida per l'installazione

+ Questi dispositivi non sono pronti per I'uso al momento della consegna, devono essere installati
e cablati secondo le indicazioni specifiche di questa documentazione al fine di rispettarne i limiti
EMC e gli standard di sicurezza.

» Linstallazione deve essere eseguita secondo questa documentazione utilizzando attrezzature e
strumenti adeguati.

« | dispositivi devono essere installati solo da personale qualificato senza tensione applicata. Prima
dell'installazione, la tensione all'armadio elettrico deve essere spenta e ne deve essere impedita
I'accensione per tutto il tempo dell'intervento.

« Devono essere osservate le linee guida generali sulla sicurezza e le norme nazionali sulla
prevenzione degli incidenti.

+ Linstallazione elettrica deve essere eseguita in conformita alle linee guida applicabili (ad esempio
sezioni trasversali della linea, fusibili, collegamenti di terra protettivi).

1.3 Virus e programmi pericolosi

Questo sistema & soggetto a potenziali rischi ogni volta che i dati vengono scambiati o il software
viene installato da un supporto dati (ad esempio CD-ROM o flash-disk USB), una connessione di
rete o Internet. Lutente e responsabile della valutazione di questi pericoli, implementando misure
preventive come programmi di protezione antivirus, firewall, ecc. e assicurandosi che il software sia
ottenuto solo da fonti attendibili.
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1.4 Organizzazione delle note di sicurezza
Le note sulla sicurezza in questo manuale sono organizzate come segue:

Note di sicurezza |Descrizione

Danger! La mancata osservanza di queste linee guida e avvisi di sicurezza puo essere
potenzialmente mortale.

La .rnapcata.osserva.nza di qqe§te linee gujdg e avvisi di sicurezza pud comportare
lesioni gravi o danni sostanziali alla proprieta.

La mancata osservanza di queste linee guida e avvisi di sicurezza puo provocare

lesioni o danni alle cose.
IIVEIINELENY | Tali informazioni sono importanti per prevenire errori.

2 TdControlPanel

Lutility TdControlPanel & I'interfaccia principale per la configurazione delle porte ed i servizi principali
del pannello operatore. Questa interfaccia & accessibile tenendo premuto I'icona “STOP” che appare
in fase di avvio del pannello, oppure dal pulsante “TdControlPanel” visibile nel progetto movicon che si
avvia automaticamente se il pannello & nuovo di fabbrica.

Quando si avvia il TdControlPanel dall'icona “STOP”, vengono interrotti tutti i servizi di sistema (quindi
LogicLab, Movicon, VNC, PixsysPortal non sono in esecuzione e non risponderanno alle eventuali
richieste di accesso/download del codice).

All'avvio del dispositivo si apre un progetto che consente
di verificare lo stato generale della macchina, data e ora di
sistema, indirizzo IP associato, esecuzione del SoftPLC in
background.

Utilizzando un client VNC & possibile visualizzare dal proprio PC quello che viene visualizzato a video
sul PLC/HMI. Avviando un browser con servizio Java attivo & inoltre possibile testare se la funzione di
Webserver del dispositivo € attiva. Per questa funzione & necessario I'uso del browser Internet Explorer.

Dal pulsante “Td Control Panel,” si accede al pannello

di controllo del dispositivo, dove é possibile verificare e
configurare i vari servizi e progetti da lanciare all'avvio,
oltre a poter configurare il tempo di attesa per lo
spegnimento della retroilluminazione, il buzzer al tocco del
display ecc.

Nei paragrafi seguenti verra descritta ciascuna funzione delle finestre presenti nel TdControlPanel.
NB: Le immagini mostrano la configurazione di default del dispositivo.
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2.a WIN EXPLORER

Da questa finestra e possibile scegliere un set di opzioni

delle modalita di avvio di Windows CE ed esecuzione di

TDControlPanel.

+ La prima opzione avvia Windows CE con desktop.

« Laseconda opzione permette l'avvio del TDControl-
Panel se, durante l'avvio del terminale, si mantiene
premuto il pulsante “Stop” @.

+ Abilitando la terza opzione sara possibile impostare
una password di protezione per evitare che utenti non
autorizzati, tenendo premuto il pulsante di “STOP” &,
accedano alle impostazioni del TDControlPanel.

Il pulsante “START WINDOWS DESKTOP” permette di avviare il servizio “Explorer.exe” e quindi di
accedere al desktop di Windows CE.

2.b HMI_MOVICON

Da questa finestra e possibile selezionare quali servizi e
programmi relativi a Movicon 11 eseguire in automatico
all'avvio del dispositivo.

Le funzionalita dello scada Movicon sono disponibili in
tutti gli HMI e nel PL500 nella versione “WEB” (PL500-
335-1AD-WEB)

Il flag “Run Project at STARTUP” avvia il progetto Movicon, indicato sopra, all'avvio del pannello.

Il flag “Run File Service at STARTUP” avvia il servizio di connessione con I'ambiente di sviluppo Movicon
allavvio del pannello.

Il flag “WATCHDOG” abilita la funzione che riavvia il progetto se il runtime Movicon si chiude
accidentalmente.

Il campo “Delay at START in seconds” inserisce un ritardo, dopo l'avvio del pannello, per I'avvio del
progetto Movicon, per dare il tempo ad un eventuale PLC di avviarsi ed essere disponibile sulla rete.
Il pulsante “SAVE” salva le modifiche e chiude la finestra.

Il pulsante “SAVE and START” avvia il progetto Movicon (ed il servizio di upload file) manualmente.

2.c PLC LOGICLAB
Da questa finestra si abilita/disabilita I'esecuzione del
SoftPLC all'avvio del dispositivo. Selezionando il flag “RUN
console DEBUG”, durante I'esecuzione del SoftPLC, la finestra
di Debug sara compilata con gli eventi di sistema in tempo
reale per poter verificare eventuali anomalie.
NB: questa funzione richiede molte risorse al dispositivo.
Si consiglia di mantenerla attiva solo se si riscontrano
problemi durante lo sviluppo del software. E bene
disabilitarla al termine della fase di sviluppo!

Il pulsante “START” avvia il progetto SoftPLC (e I'eventuale finestra di debug) manualmente.
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2d

LAN ETH1

Da questa finestra e possibile modificare i parametri della
porta Ethernet 1 del dispositivo.

Abilitando il flag “DHCP Enabled” si configura la porta in
modalita DHCP, altrimenti vanno inseriti manualmente tutti
i parametri IP nei campi disponibili sotto.

Abilitando il flag “Bridge” si configurano le due porte ETH1

e ETH2 in modalita “switch”, realizzando una connessione
di tipo daisy-chain (o a cascata) di piu dispositivi senza
utilizzare switch Ethernet esterni.

Disabilitando il flag “Bridge” si dovra configurare ciascuna porta Ethernet con il proprio indirizzo IP,
ottenendo due reti completamente isolate tra loro.
NB: Lindirizzo IP di default dei pannelli operatore ¢ 192.168.0.100 ed ¢ abilitata la modalita “Bridge”.

2.e

2.f

LAN ETH2

BACKLIGHT - BUZZER

Da questa finestra e possibile modificare i parametri della
porta Ethernet 2 del dispositivo se disponibile e se non e
stata abilitata la modalita “switch” nella scheda LAN ETH1.
Nel caso di pannelli con una sola porta ethernet, e possibile
ottenere una seconda porta Ethernet collegando alla

porta USB il convertitore USB-Ethernet con nostro codice
2400.70.005.

Abilitando il flag “DHCP Enabled” si configura la porta in
modalita DHCP, altrimenti vanno inseriti manualmente tutti
i parametri IP nei campi disponibili sotto.

Da questa finestra e possibile configurare i parametri
relativi la retroilluminazione e il buzzer.

Abilitando la funzione “Always ON” |a retroilluminazione
resta sempre attiva, nel caso contrario nel terzo campo
“Backlight ON for..(sec)” si dovra inserire il tempo in secondi
per avviare lo spegnimento o l'attenuazione della lampada.
Nel 1° e 2° campo si possono impostare: la percentuale di
accensione della lampada (100% = accesa, 0%=spento)
nello stato di lavoro normale o nello stato di standby.

Il quarto campo “Buzzer frequency” permette di impostare la
frequenza del suono del buzzer: piu la frequenza ¢ alta piu
il suono sara acuto.

Il flag “Buzzer OFF” disabilita il buzzer al tocco del touch. | pulsanti “TEST” permettono di testare i
parametri impostati prima di salvare la configurazione.

29

WINVNC

Abilitando il flag “RUN VNC at STARTUP” si configura il
pannello operatore per avviare automaticamente il servizio
VNC server ad ogni accensione.

Abilitando il flag “DAILY RESTART AT HOURS (0..23)" si
configura un ora del giorno in cui il servizio viene riavviato
automaticamente.

Il pulsante “START VNC” avvia manualmente il servizio.

Il pulsante “KILL VNC” termina manualmente il servizio.

Il pulsante “START CONFIG” apre la finestra di configurazione
di VNC per poter impostare il sistema di autenticazione,
cambiare la password di accesso ecc.
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Attenzione la modifica dei parametri € consigliata per utenti avanzati, la manomissione dei
parametri in modo errato provochera il malfunzionamento del servizio di desktop remoto.
L'accesso al VNC server utilizza la porta 5900 ed & anonimo di default.

2.h VPN

Da questa finestra e possibile accedere all’interfaccia di
configurazione del servizio VPN PixsysPortal, nonché
avviarlo o terminarlo manualmente.
Abilitando il flag “RUN VPN at STARTUP” si configura il
pannello operatore per avviare automaticamente il servizio
PixsysPortal ad ogni accensione.
“Start VPN” avvia il servizio manualmente (se non & gia
avviato), “KILL VPN” termina il servizio manualmente (se in
esecuzione).
Per maggiori informazioni sulla configurazione ed i requisiti del servizio, fare riferimento alla
documentazione reperibile dalla pagina dedicata nel nostro sito
https://www.pixsys.net/convertitori-gateway/gateway-vpn/pixsys-portal

2. MQTT
Da questa finestra e possibile configurare le funzioni MQTT
disponibili nei pannelli operatore con SoftPLC integrato.
Il servizio & un “ModbusTCP master --> MQTT client” che
recupera i dati dalle status variables del LogicLab e le
pubblica come MQTT client al server impostato.
Abilitando il flag “Enable MQTT CLIENT” si attiva il servizio
all'avvio del pannello operatore.
Nel campo “BROKER” va inserito I'indirizzo IP del server
MQTT su cui il pannello pubblichera i topic (lasciare la
porta 443).

Nei campi “USER” e “PASS” vanno inserite le credenziali per la connessione al server MQTT.

Il campo “Client ID” configura i topic pubblicati con la seguente sintassi “USER/Client ID”, lasciando

%MAC il Client ID sara il MAC address del pannello operatore.

Premendo “SAVE” si applica la configurazione effettuata.

Con il pulsante freccia si accede alla seconda pagina, descritta qui di seguito.

NB: tutte le opzioni non descritte sono in fase di sviluppo e non sono ancora disponibili.
Nel campo “IP SERVER Modbus_TCP” va inserito I'indirizzo
IP del dispositivo ModbusTCP slave che il servizio
interroghera per recuperare i dati da pubblicare, lasciando
127.0.01 si intende il dispositivo stesso, indipendentemente
dalla configurazione di rete di questo (lasciare sempre la
porta 502).
| campi “n° INT16,INT32,FLO32 MB_TCP” indicano quanto
i registri saranno interrogati lato ModbusTCP (e quindi
pubblicati lato MQTT) a partire dal campo “ADDR” indicato.

| campi “DSec” indicano i tempi di pubblicazione dei topic, espressi in decimi di secondo. Se lasciati a

0, la pubblicazione avviene solo su variazione del dato di origine.

Ad esempio impostando “n° INT16 MB_TCP” a “2", "ADDR” a “10010” e “DSec” a “10”, i registri 10010 e

10011 saranno interrogati dal dispositivo ModbusTCP slave e pubblicati ogni secondo.

NB: tutte le opzioni non descritte sono in fase di sviluppo e non sono ancora disponibili.
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2

FTP

Da questa finestra e possibile configurare le funzioni FTP e
TELNET del dispostivo.

| campi “FTP Enabled” e “TELNET Enabled” attivano
rispettivamente i servizi di FTP server e TELNET integrati
nei pannelli operatore.

| campi “Anonymous Access” permettono, per il rispettivo
servizio, 'accesso anonimo. Se una delle due spunte
indicate e disabilitata, I'accesso al relativo servizio &
permesso con le credenziali impostabili nei campi
disponibili sotto (massimo 2 utenti).

NB: di default entrambi i servizi sono attivi e non necessitano di credenziali per I'accesso (accesso
anonimo).

2.k

BACKUP-RESTORE

BACKUP: procedura per eseguire il backup (caricamento da HMI) dei progetti LogicLab e Movicon.

Una volta scaricati i progetti LogicLab e Movicon sul
dispositivo e configurato quest’ultimo in modo da eseguirli
ad ogni accensione, spegnere e riaccendere il dispositivo
tenendo premuto il simbolo di “STOP”

In questo modo si avvia la finestra del TDControlPanel

A questo punto inserire una penna USB, formattata in
FAT32, su una delle porte USB disponibili.

Premere “BACKUP-RESTORE" per accedere all'utility che
permette il backup dei progetti e della configurazione del
dispositivo.

Da questa finestra si puo scegliere di quali risorse effettuare il backup:

PLC_LOGICLAB (RUNTIME-PROJECT): esegue il backup del progetto LogicLab (e dell'intero
Runtime), oltre che della configurazione effettuata nella finestra “PLC_LOGICLAB" (accessibile dalla
finestra principale del TDControlPanel).

HMI_MOVICON(PROJECT): esegue il backup del solo progetto Movicon, oltre che della configura-
zione effettuata nella finestra “HMI_MOVICON" (accessibile dalla finestra principale del TDControl-
Panel).

HMI_MOVICON (RUNTIME): esegue il backup del solo Runtime

TdControlPanel (Configuration): esegue il backup dell'intera configurazione effettuata nelle varie
utility accessibili dalla finestra principale del TdControlPanel. NB: In questo modo si effettua il
backup anche dell’'eventuale password di accesso al TdControlPanel, se impostata dalla finestra
“WIN EXPLORER”.

LAN (IP CONFIGURATION): esegue il backup della configurazione di rete del dispositivo.
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- BOOT SCREEN: esegue il backup dell'immagine di sfondo che si visualizza durante I'avvio del

sistema.

Abilitando tutte le spunte, si ottiene un backup completo della configurazione e dei software presenti
nel dispositivo, utile per velocizzare la programmazione in serie di pit pannelli operatore.

Premendo il tasto “BACKUP TO USB DISK” verra aperta

la memoria USB collegata al terminale e sara possibile
selezionare una cartella di destinazione ed il nome del file
di backup (il nome predefinito del file sara la data e I'ora di
creazione di questo).

Premendo “OK” la procedura di backup inizia (si vedra una
clessidra al centro dello schermo).

Un popup di conferma indica il termine della procedura.
Premendo “OK” si chiude il popup ed & quindi possibile
premere “ESC” e poi spegnere il dispositivo.

RESTORE: procedura per eseguire il ripristino (caricamento su HMI) dei progetti LogicLab e Movicon.
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Per effettuare la programmazione di un nuovo dispositivo
a partire da un backup, tenere premuto il simbolo di “STOP”
in fase di accensione.

In questo modo si avvia la finestra del TDControlPanel

A questo punto inserire la penna USB contenente il Backup
su una delle porte USB disponibili.

Premere “BACKUP-RESTORE" per accedere all'utility che
permette il ripristino dei progetti e della configurazione
del dispositivo.



Premendo il tasto “RESTORE FROM USB DISK” verra aperta
la memoria USB collegata al terminale e sara possibile
selezionare il file di backup creato precedentemente.

Premendo “OK” la procedura di restore inizia (si vedra una
clessidra al centro dello schermo).

Un popup di conferma indica il termine della procedura.
Premendo “OK” si chiude il popup ed é quindi possibile
premere “ESC” e poi spegnere il dispositivo.

Da questo momento, ad ogni accensione il dispositivo avviera i progetti (e I'intera configurazione se
selezionata durante la fase di backup) automaticamente.

3 Suite LogicLab (solo HMI+SoftPLC)

La Suite LogicLab e I'ambiente di sviluppo di Pixsys per la programmazione del PLC PL500 e di tutta la
famiglia di terminali operatore e PanelPC.

La suite & scaricabile dall'area download del sito pixsys.net, previa registrazione e non necessita di
codici di attivazione. E compatibile con tutte le versioni di Windows 32/64bit a partire da Windows
XP SP3 ed é disponibile in lingua inglese e in italiano. Una volta scaricato il file di setup sul proprio
computer, avviare l'installazione e seguire la procedura standard. Una volta installato il programma,
si avvia tramite |'icona "LogicLab” @ sul desktop oppure dal menu “Start” > “PixsysSuite” > “LogicLab”.

3.a Cambio lingua

Per cambiare la lingua di visualizzazione &
necessario aprire la finestra delle opzioni dal
menu “File” > “Options”, passare alla scheda
“Language”, selezionare la voce “ITA - italiano”
e premere “Select”. Confermare quindi con “OK”
ed infine chiudere e riaprire LogicLab affinché
le modifiche abbiano effetto.

3.b Creazione - caricamento di un progetto

Apertura di un progetto esistente:

« Con LogicLab aperto, fare click sul pulsante
“Apri progetto” oppure selezionare uno degli
ultimi progetti aperti dall’elenco proposto.

» Con LogiclLab chiuso, entrare nella cartella del
progetto e fare doppio click sul file con il nome
del progetto desiderato che avra I'icona @ ed
estensione “.plcprj"”.
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Creare un nuovo progetto:

Premere il pulsante “Nuovo Progetto”.

Nella finestra che appare, digitare un nome per il
progetto ed identificare la cartella dove verranno
inseriti i file del progetto. Selezionare infine il
dispositivo che si vuole programmare.

Attenzione: selezionando il flag “rispetta maiuscole/minuscole”, una variabile che contiene una lettera
maiuscola sara intesa come diversa da un‘altra di uguale nome ma con tale lettera minuscola.
Consigliamo quindi di lasciare disabilitata tale selezione, per evitare confusione durante la stesura del
codice programma.

3.c Collegamento al target

Si elencano di seguito i requisiti necessari per il corretto collegamento tra target (dispositivo da

programmare) e I'ambiente di sviluppo su PC (LogicLab).

Requisiti da verificare sul target:

« dispositivo acceso e avviato

- configurato con indirizzo IP statico compatibile con la rete dove si trova ed il PC con cui si
dovra connettere. Di default, I'indirizzo IP dei terminali HMI ¢ 192.168.0.100, quello del PL500 e
192.168.0.99, quindi il PC dove si sta sviluppando dovra avere la stessa rete e classe (in questo caso
192.168.0.XXX) ma indirizzo fisico diverso (cioé le ultime 3 cifre dell'indirizzo IP, con un qualsiasi
numero compreso tra 1 e 255, diverso da 100). Se & necessario cambiare I'indirizzo IP del terminale
rispetto a quello di default, fare riferimento alla configurazione del TD Control Panel, sezione “LAN
ETH1" al par. 2.d.

« connessione con cavo di rete (diretto o cross) direttamente al PC o attraverso uno switch di rete

+ SoftPLCin esecuzione (per questo fare riferimento alla configurazione del TD Control Panel, sezione
“PLC LOGICLAB" al par. 2.c).

Requisiti da verificare sul PC di sviluppo:

- indirizzo IP compatibile con la rete esistente dove si trova e con I'indirizzo IP configurato nel target
(vedi punti precedenti)

+ antivirus/firewall che permetta la connessione a dispositivi nella rete (di norma sono gia configurati
correttamente)

- LogicLab configurato per connettersi al target collegato che si vuole programmare: per fare cio,
navigare sul menu “On Line” > “Imposta comunicazione” e nella finestra che appare, premere il
pulsante “Properties” e poi alla voce “IP Address” inserire I'indirizzo IP del target, lasciando inalterato
tutto il resto. Nel caso di reti molto lente o di una configurazione di rete con diversi switch, &
possibile aumentare il valore “Timeout” (espresso in mS).

Limmagine rappresenta la configurazione di default
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Confermare tutte le finestre premendo su “OK” e salvare attraverso I'icona o attraverso il menu “file”
> “Salva Progetto”.

A questo punto, per verificare che la configurazione del LogicLab e del target sia corretta, si puo
effettuare la connessione premendo licona ¥ oppure dal menu “On Line” > “Connetti”. Se la
connessione va a buon fine la barra di stato in basso a destra visualizzera “CONNESSO” e “NO CODICE”
ad indicare che il target € connesso e non ha codice al suo interno oppure “CODICE DIFF” ad indicare
che il codice che si sta visualizzando non corrisponde a quello che risiede nel target.

3d Compilazione e scaricamento del codice

Una volta inserito il codice progetto € necessario compilarlo per verificare che non ci siano errori,
premendo il tasto F7, attraverso |'icona i oppure dal menu “Progetto” > “Compila”.

Se la compilazione va a buon fine si puo trasferire il programma al target premendo il tasto F5,
attraverso I'icona  oppure dal menu “On Line” > “Trasferimento codice”.

A questo punto la barra di stato visualizzera “CONNESSO” e “SORGENTE OK” indicando che il programma
in esecuzione nel target corrisponde a quello che si sta visualizzando sul PC.

3.e La watch window

Se il programma in esecuzione nel target corrisponde a quello che si sta visualizzando sul PC, la barra
di stato visualizza “CONNESSO” e “SORGENTE OK” ed e quindi possibile utilizzare la finestra di “Watch”
per verificare, in tempo reale, lo stato delle variabili utilizzate nel progetto. Per abilitare la finestra
di “Watch”, premere i tasti CTRL+T oppure usare il menu “Vista” > “Finestra strumenti” > “Watch”. Per
aggiungere una variabile alla finestra di “Watch” & sufficiente trascinarla al suo interno oppure premere
licona e selezionarla manualmente.

Da questo momento, la finestra di “Watch”
comincera a visualizzare il valore della variabile
inserita, in tempo reale.

Attraverso gli appositi pulsanti & possibile inoltre salvare, caricare e aggiungere all'elenco
delle variabili, una watch-list gia esistente.

Se si desidera cambiare il formato di visualizzazione, &
sufficiente selezionare la variabile e premere I'icona m@.
Dalla finestra che appare selezionare quindi il formato
desiderato e confermare con “OK”.
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4 Interfacciare Movicon 11 e LogicLab (solo HMI+SoftPLC)

NB: e richiesto Movicon 11.5 o successivi.

Da effettuare solo la prima volta:

Nel PC dove si sta sviluppando, scaricare dall'area dowload del sito Pixsys, nella sezione Movicon,
il “MOVICON 11.6 Update-Aggiorna Driver.exe” corrispondente all’architettura del pc in uso. Doppio
click per avviarlo e seguire le istruzioni a video.

Nel caso si utilizzi un Panel PC (TD750-TD850-TD900-TD910-TD920) va fatto anche sul Panel PC.
Premessa: con questa procedura vengono importate tutte le variabili di sistema del PLC e tutte le
variabili create ed usate nel progetto PLC.

La creazione e I'aggiornamento dell’elenco delle variabili PLC avviene solamente se il programma
LogicLab & compilato senza errori e scaricato sul target.

4.a Creazione di un nuovo progetto Movicon

Avviare il software e scegliere |a piattaforma “Windows® X86 / X64" per i Panel-PC e “Windows® CE” per gli
HMI e per il PL500 versione “WEB”. Se si sta creando un nuovo progetto Movicon seguendo il Wizard,
al termine verra visualizzata la finestra di configurazione del driver, passare quindi direttamente alla
sezione “Configurazione del Driver” al par. 4.b. Se invece si sta installando il driver manualmente, seguire
i passi successivi.

Aggiungere il driver di comunicazione facendo
click con tasto destro su “Real time DB” quindi
“nuovo driver di comunicazione”.

Selezionare dal menu dei produttori “Pixsys” e
poi “Pixsys SoftPLC Driver”.

Confermare con “OK” e fare doppio click sul
driver appena creato per aprire la finestra di
configurazione.

4.b Configurazione del Driver

Selezionare la scheda “Station” e aggiungere
una nuova stazione con il pulsante “ADD".
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1. Inserire il percorso del file dei simboli del
PLC, presente nella sottocartella “Build”
della cartella che contiene i file del progetto
LogicLab. Il file ha estensione .SYM.XML
e permette di importare la variabili PLC
all'interno del progetto Movicon.

2. Questo campo si autocompila dopo aver inserito il percorso del punto 1: nel caso di utilizzo degli

HMI e del PL500, non modificare il campo auto-compilato. Nel caso di Panel-PC (TD750-TD850-
TD900 ecc.) inserire il percorso dove e stato effettuato il download del progetto LogicLab (di
default “D:\LLExec\NomeMioProgettoLogicLab.sym.xml").

. Se l'applicativo Movicon sara eseguito nel Panel HMi o nel Panel-PC dove & presente anche il
SoftPLC, inserire I'lP address 127.0.0.1.

Se invece Movicon sara eseguito in un Panel HMi o Panel-PC diverso da dove risiede il SoftPLC,
si dovra inserire l'indirizzo IP del softPLC. Questo permette anche di eseguire, in modalita
preview, il progetto Movicon sul proprio PC di sviluppo, compresa la verifica della comunicazione
con il SoftPLC. Per questa funzione, & necessario indicare I'indirizzo IP del terminale che si sta
programmando (solo al termine dello sviluppo si dovra inserire I'indirizzo localhost 127.0.0.1 per
far si che il runtime Movicon risiedente nel pannello comunichi con il SoftPLC in esecuzione nella
stessa macchina).

4. Dalla sezione “General” assegnare un nome alla stazione, ad esempio: “PLC".
Premere OK per salvare le impostazioni e uscire.

Ora e possibile importare le variabili del
progetto LogicLab in Movicon.

Premere il tasto destro su “Pixsys SoftPLC" e
selezionare “Importa database PLC".

Premere il tasto “Read from PLC project”, verra
fornito I'elenco delle variabili disponibili.

Selezionare quindi le variabili che si vogliono
importare e premere il tasto “Import”.

NB: Nel caso di importazione di una variabile di tipo array, questa sara visualizzata come una struttura
che porta il nome del array. | singoli membri dell’array saranno accessibili singolarmente con la sintassi
NomeMioArray:NomeMioArray _X dove X € I'indice dell’array (a partire da 0).

Ora le variabili sono disponibili nel progetto di Movicon. Qualora ci fosse la necessita di importare
nuove variabili, ad esempio nel caso di modifica del progetto di LogicLab, ripetere solo la procedura
di lettura ed importazione delle variabili.
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4.c
Per trasferire il progetto Movicon, usare I'icona:

1.
2. Inserire I'indirizzo IP del target (default per HMI/

Trasferimento del codice Movicon nel target

Selezionare il protocollo per il trasferimento: TCP

PLC: 7192.168.0.100)

. Nel caso di HMI/PLC lasciare vuoto, nel caso di

Panel-PC inserire user (o il nome dell’'utente con
cui si e effettuato I'accesso nel Panel-PC target).

. Nel caso di HMI/PLC lasciare vuoto, nel caso di

Panel-PC inserire 123456

. Nel caso di HMI/PLC inserire \NandFlash\No-

meMioProgettoMovicon\, nel caso di Panel-PC
inserire D:\NomeMioProgettoMovicon\.

In questo modo Movicon creera una cartella
chiamata NomeMioProgettoMovicon e scarichera
tutti i file del progetto dentro ad essa.

NB: & importante che l'inizio del percorso
indicato sia \NandFlash\ (e poi il nome della
sottocartella che verra creata) altrimenti i file
del progetto saranno trasferiti in RAM e quindi
verranno persi allo spegnimento del pannello!

6. Premete il tasto “Trasferisci Progetto (Upload)” per avviare il trasferimento (premere “Yes to All" nel
caso sia gia stato scaricato un progetto precedentemente e si voglia sovrascriverlo).

7. Una volta terminato la procedura di download, premere “Avvia Progetto sul Dispositivo” per farlo
eseguire sul target (il progetto in esecuzione sara terminato e si avviera l'ultimo trasferito).

NB: Nel caso si vogliano trasferire piu progetti/versioni differenti, & sufficiente cambiare la cartella

di destinazione (va mantenuto comunque la prima parte \NandFlash\). Dal TdControlPanel si dovra

scegliere quale progetto tra i presenti nella memoria del dispositvo si dovra avviare in automatico

all'accensione del target (vedi paragrafo 10.b).

NB2: Il pulsante “Cancella Memory Card dispositivo” permette di cancellare la cartella indicata nel
campo “Cartella dispositivo”, ripulendo il pannello da file del progetto contenuto in essa. E' importante
ricordare che se non viene indicata alcuna cartella sotto \NandFlash\ questo pulsante eliminera tutti i
file risiedenti nella \Nandflash\ stessa, rendendo il pannello inutilizzabile!
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5 Simulazione dell'intero progetto SoftPLC + SCADA
(solo HMI+SoftPLC)

Da LogicLab, lanciare il simulatore dallicona = oppure dal menu “Debug” > “Modo simulazione”. Nella
finestra che appare, creare una nuova area di lavoro indicandone il nome e la cartella di destinazione
(di default é selezionata la cartella dove risiede il progetto).

A questo punto, il simulatore risultera avviato e connesso (la finestra di stato segnalera lo stato
“CONNESSO”) ma senza codice (la finestra di stato segnalera lo stato “NO CODICE"), trasferire quindi il
codice premendo il tasto F5, attraverso I'icona  oppure dal menu “Online” > “Trasferimento codice”.
Verificare che la barra di stato visualizzi “CONNESSO” e “SORGENTE OK”. In caso si visualizzi ancora “NO
CODICE"), riavviare il simulatore premendo l'icona % oppure dal menu “On-line” > “Target reboot”.

Da Movicon, entrare nella finestra di configurazione del driver Pixsys e configurare come segue:

1. Entrare nella cartella dove risiede il
progetto LogicLab (sottocartella “Build”) e
selezionare il file NomeMioProgettoLogi-
cLab.sym.xml

2. Entrare nella cartella dove il simulatore
sta lavorando, impostare come filtro per
il tipo di file “All files (**) e selezionare il
file  NomeMioProgettoLogicLab.sym.simul.
Fare molta attenzione all’estensione del
file, in quanto nella cartella di progetto
esistono molti file con lo stesso nome ma
con estensione differente.

3. Impostare I'indirizzo localhost: 127.0.0.1

4. Dalla sezione “General” assegnare un
nome alla stazione, ad esempio: “PLC".

A questo punto, per lanciare la simulazione dell'interfaccia grafica collegata al simulatore (che sta
gia eseguendo il codice precedentemente scaricato) & sufficiente premere i tasti Alt+F12, I'icona
oppure dal menu “File” > “Avvia Progetto”.

Per terminale la simulazione, premere i tasti Alt+F12 oppure I'icona  nella barra che appare in alto.
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Responsabilita limitata

Pixsys S.r.l. garantisce le proprie apparecchiature elettroniche per un periodo di 12 mesi a decorrere
dalla data di fatturazione. La garanzia del Costruttore & limitata alla riparazione o sostituzione delle
parti che presentino difetti di fabbricazione e che siano rese franco nostra sede citando il numero di
autorizzazione al reso (procedura interna autorizzazione RMA). Pixsys declina ogni responsabilita per
incidenti e danni a persone o cose derivanti da manomissione (inclusi tentativi di riparazione da parte
di personale non autorizzato), condizioni ambientali non idonee, installazione scorretta, uso errato,
improprio e comunque non conforme alle caratteristiche dello strumento dichiarate nella documen-
tazione tecnica. In nessun caso la responsabilita del costruttore eccede il valore della strumentazione.
La garanzia non copre in alcun modo i problemi derivanti dall’installazione di applicativi software
successiva alla vendita, ed in particolare i danni conseguenti all'esecuzione di malware. Eventuali
interventi di assistenza da parte di Pixsys per il ripristino di sistema operativo o programmi saranno
soggetti alla tariffa di assistenza vigente.

Note / Aggiornamenti
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1 Sicherheitsvorschriften

Diese Bedienungsanleitung bezieht sich auf Pixsys-Produkte wie speicherprogrammierbare
Steuerungen (SPS) sowie Steuerungs- und Uberwachungsgerite (Industrierechner, HMIs). Sie werden
inder Folge einfach als ,Gerdt” oder ,Gerdte” bezeichnet. Die von Pixsys entwickelten und vertriebenen
Gerate werden fiir den konventionellen Einsatz in Industrieumgebungen entworfen, entwickelt und
hergestellt. Sie sind nicht fiir andere Verwendungszwecke ausgelegt. Jede andere Verwendung kann
bei fehlendem Einsatz von gerdteunabhdngigen, eigenstdndigen Sicherheitssystemen ernsthafte
Risiken oder Gefahren wie Tod, Verletzungen oder schwere kérperliche Schaden mit sich bringen.
Diese Risiken und Gefahren umfassen insbesondere die Verwendung dieser Gerite zur Uberwachung
von Kernreaktionen in Kraftwerken, in Flugkontroll- oder Flugsicherheitssystemen, zur Steuerung
von Massentransportsystemen und zur Unterstiitzung lebensrettender medizinischer Systeme oder
Waffensysteme.

1.1 Vorschriften und Verfahren

Elektronische Gerate bieten nie vollige Sicherheit. Ist das Gerat gestort oder nicht mehr funktionstiich-
tig, hat der Anwender dafiir zu sorgen, dass andere angeschlossene Geréte, beispielsweise Motoren,
gesichert werden. Bei Verwendung der Geréte als Steuerungssysteme in Verbindung mit SoftPLC sind
die Sicherheitsvorkehrungen fiir industrielle Steuerungen in Ubereinstimmung mit den geltenden
nationalen und internationalen Vorschriften zu treffen. Gleiches gilt fir alle anderen an das System
angeschlossenen Geréte. Alle Arbeiten wie die Installation, Inbetriebnahme und Instandhaltung der
Gerate missen von qualifiziertem Fachpersonal durchgefiihrt werden.

Das qualifizierte Fachpersonal muss mit dem Transport, der Montage, der Installation, der Inbetrieb-
nahme und dem Betrieb der Gerédte vertraut sein und die fiir den Betrieb erforderlichen Qualifikationen
(z.B. IEC 60364) besitzen. Dabei missen die nationalen Unfallverhiitungsvorschriften zur Anwendung
kommen.

Die in den technischen Daten enthaltenen Sicherheitshinweise, Verdrahtungsbedingungen
(Typenschilder und Anleitungen) und Grenzwerte sind vor der Installation und Inbetriebnahme
sorgféltig zu lesen und immer zu beachten.

1.2 Installationsrichtlinien

+ Diese Geréte sind zum Zeitpunkt der Lieferung nicht betriebsbereit. Sie miissen unter Beachtung
der vorliegenden Bedienungsanleitung installiert und verdrahtet werden, damit die EMV-Grenz-
werte und Sicherheitsvorschriften eingehalten werden kdnnen.

« Die Installation muss gemdaR der vorliegenden Bedienungsanleitung mit geeigneten Geréaten und
Werkzeugen durchgefiihrt werden.

+ Die Gerate dirrfen nur von Fachpersonal und im spannungsfreien Zustand installiert werden. Vor
der Installation muss die an den Schaltschrank angelegte Spannung unterbrochen werden und fiir
die gesamte Dauer der Arbeiten unterbrochen bleiben.

+ Die allgemeinen Sicherheitsrichtlinien und die nationalen Unfallverhiitungsvorschriften sind
immer zu beachten.

- Die elektrische Installation muss gemaR den geltenden Richtlinien (z.B. Leitungsquerschnitte,
Sicherungen, Schutzerdungen) durchgefiihrt werden.

1.3 Viren und gefahrliche Programme

Bei jedem Datenaustausch oder bei der Installation der Software ausgehend von einem Datentrager
(CD-Rom oder USB-Flashspeicher) oder bei einer Netzwerkanbindung oder Internetverbindung ist
dieses System potentiellen Risiken ausgesetzt. Zur Vermeidung solcher Gefahren obliegt es dem
Anwender, Schutzmaf3nahmen wie die Installation von Virenschutzprogrammen, Firewalls usw. zu
ergreifen und sicherzustellen, dass die Software nur aus zuverlassigen Quellen bezogen wird.
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14 Bedeutung der Sicherheitshinweise
Die Sicherheitshinweise in diesem Handbuch sind wie folgt zu verstehen:

Sicherheitshinweise |Beschreibung

Die Nichtbeachtung dieser Richtlinien und Sicherheitshinweise kann lebens-
1

gefahrlich sein.

Die Nichtbeachtung dieser Richtlinien und Sicherheitshinweise kann zu schweren
al

Verletzungen oder erheblichen Sachschaden fiihren.

Vorsicht! Die Nichtbeachtung dieser Sicherheitsrichtlinien und Warnungen kann zu
Verletzungen oder Sachschéden fiihren.

Hinweis!| Diese Informationen sind wichtig, um Fehlern vorzubeugen.

2 TdControlPanel

Das Dienstprogramm TdControlPanel ist die Hauptschnittstelle fiir die Konfiguration der wichtigsten
Anschlisse und Dienste des Bedienfelds. Auf diese Schnittstelle kann durch Gedriickthalten des
“STOP"-Symbols zugegriffen werden, das beim Starten des Panels erscheint, oder tiber die Schaltflache
“TdControlPanel”, die im movicon-Projekt sichtbar ist und automatisch gestartet wird, wenn das Panel
ganzneuist.

Wenn das TdControlPanel Uber das “STOP”-Symbol gestartet wird, werden alle Systemdienste
unterbrochen (d.h. LogicLab, Movicon, VNC, PixsysPortal werden nicht ausgefiihrt und reagieren nicht
auf Anfragen zum Zugriff/Download von Code).

Beim Hochfahren des Gerats wird ein Projekt geoffnet,
welches den allgemeinen Gerédtestatus, das Systemdatum,
die Systemzeit, die zugehorige IP-Adresse und die
Ausfiihrung von SoftPLC im Hintergrund tberpriifen lasst.

Mit einem VNC-Client kann vom eigenen Rechner aus der Bildschirminhalt der SPS/HMI visualisiert
werden. Durch Starten eines Browsers mit aktivem Java-Dienst kann auch getestet werden, ob
die Webserver-Funktion des Gerdts aktiv ist. Flir diese Funktion ist der Internet-Explorer-Browser
erforderlich.

Uber die Schaltfliche ,Td Control Panel” wird das
Bedienterminal des Gerats aufgerufen. Dort kénnen die
verschiedenen Dienste und Projekte, die beim Einschalten
gestartet werden sollen, Gberprift und konfiguriert
werden, ebenso wie die Wartezeit bis zum Ausschalten der
Hintergrundbeleuchtung, der Summer bei Berlihrung des
Displays usw.

In den folgenden Abschnitten werden die einzelnen Funktionen im TdControlPanel beschrieben.
Anmerkung: Die Fotos beziehen sich auf die Standardkonfiguration des Gerits.
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2.a WIN EXPLORER

In diesem Fenster kdnnen die Startoptionen von Windows

CE und die Ausfiihrungsoptionen von TDControlPanel

gewahlt werden.

+ Die erste Option startet Windows CE mit dem Desktop.

. Die zweite Option startet TDControlPanel, wenn
beim Starten des Bedienterminals die Stopp-Taste &
gedriickt wird.

« Die dritte Option ldsst einen Passwortschutz einrichten,
damit unbefugte Benutzer nicht auf die Einstellungen
des TDControlPanel zugreifen kdnnen. Hierzu wird
die Stopp-Taste € gedriickt gehalten, um zu den
Einstellungen des TDControlPanel zu gelangen.

Mit der Schaltflache ,START WINDOWS DESKTOP* wird der Dienst ,Explorer.exe” gestartet und erfolgt
der Zugriff auf den Desktop von Windows CE.

2.b HMI_MOVICON

In diesem Fenster kann gewdhlt werden, welche Dienste
und Programme in Bezug auf Movicon 11 beim Start des
Gerats automatisch ausgefiihrt werden sollen.

Die Movicon-SCADA-Funktionen sind in allen HMIs und
im PL500 in der ,WEB"-Version (PL500- 335-1AD-WEB)
verfiigbar.

Das Flag ,Run Project at STARTUP” startet das Movicon-Projekt beim Start des Panels.

Mit dem Flag ,Run File Service at STARTUP” wird der Verbindungsdienst mit der Movicon-Entwi-
cklungsumgebung beim Start des Panels gestartet.

Das Flag ,WATCHDOG" aktiviert die Funktion, die das Projekt neu startet, wenn die Movicon-Lauf-
zeitumgebung versehentlich geschlossen wird.

Das Feld ,Verzogerung beim START in Sekunden” fligt eine Verzégerung fiir den Start des Movicon-
Projekts ein, nachdem das Panel hochgefahren ist, um jeder SPS Zeit zu geben, hochzufahren und im
Netzwerk verfligbar zu sein.

Die Schaltflache ,SAVE and START" startet das Movicon-Projekt (und den Datei-Upload-Service)
manuell.

2.c PLC LOGICLAB
Dieses Fenster aktiviert/deaktiviert die Ausfiihrung von
SoftPLC beim Gerétstart. Durch die Wahl des Flags ,RUN
console DEBUG" wird das Debug-Fenster wahrend der
Ausfiihrung von SoftPLC mit Echtzeit-Systemereignissen
gefillt, um auf Anomalien zu priifen.
Anmerkung: Diese Funktion ist sehr ressourcenaufwandig.
Es empfiehlt sich, sie nur aktiv zu halten, wenn bei der
Softwareentwicklung Probleme auftreten. Sie sollte nach
Beendung der Entwicklungsphase deaktiviert werden!

Die Schaltflache ,START" lasst das SoftPLC-Projekt (und ggf. das Debug-Fenster) manuell starten.
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2d

LAN ETH1

In diesem Fenster kdnnen die Parameter des Ethernet-Por-
ts 1 des Gerdts geandert werden.

Durch Aktivieren der Flagge “DHCP Enabled” wird der Port
im DHCP-Modus konfiguriert, andernfalls miissen alle
IP-Parameter manuell in die unten verfligbaren Felder
eingegeben werden.

Durch Aktivieren der Flagge “Bridge” werden die beiden
Ports ETH1 und ETH2 im “Switch”-Modus konfiguriert,
wodurch eine Verkettung (oder Kaskade) mehrerer Gerate
ohne Verwendung externer Ethernet-Switches moglich ist.

Bei Deaktivierung des “Bridge”-Flags muss jeder Ethernet-Anschluss mit einer eigenen IP-Adresse
konfiguriert werden, was zu zwei vollstandig isolierten Netzwerken fihrt.
Hinweis: Die Standard-IP-Adresse der Bedienterminals lautet 192.168.0.100 und der “Bridge”-Modus

ist aktiviert.
2.e LAN ETH2
2.f BACKLIGHT - BUZZER

In diesem Fenster ist es moglich, die Parameter des
Ethernet-Ports 2 des Gerats zu andern, wenn dieser
verfiigbar ist und der “Switch”-Modus auf der Karte LAN
ETH1 nicht aktiviert wurde.

Bei Panels mit nur einem Ethernet-Port ist es mdglich,
einen zweiten Ethernet-Port zu erhalten, indem der
USB-Ethernet-Konverter mit unserem Code 2400.70.005 an
den USB-Port angeschlossen wird.

Durch Aktivieren des Flags “DHCP Enabled” wird der Port
im DHCP-Modus konfiguriert, andernfalls miissen alle
IP-Parameter manuell in die unten verfligbaren Felder
eingegeben werden.

In diesem Fenster kdnnen die Parameter fiir die Hinter-
grundbeleuchtung und den Summer konfiguriert werden.
Bei Aktivierung der Funktion ,Always ON” bleibt die
Hintergrundbeleuchtung immer eingeschaltet; andernfalls
muss im dritten Feld ,Backlight ON for..(sec)” die Zeit in
Sekunden eingegeben werden, nach welcher die Lampe
ausgeschaltet oder gedimmt werden soll. Im 1. und 2. Feld
kann der Prozentsatz der Beleuchtung (100% = eingeschal-
tet, 0% = ausgeschaltet) im normalen Betriebszustand oder
im Standby-Zustand eingestellt werden. Im vierten Feld
,Buzzer frequency” kann die Frequenz des Summertons
eingestellt werden: Je héher die Frequenz, desto lauter

ist der Ton. Das Flag ,Buzzer OFF” schaltet den Summer

bei Beriihrung aus. Mit den Schaltflachen ,TEST” kénnen
die eingestellten Parameter getestet werden, bevor die
Konfiguration gespeichert wird.
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2.g  WINVNC

Wenn Sie das Flag ,RUN VNC at STARTUP” aktivieren, wird
das Bedienfeld so konfiguriert, dass der VNC-Serverdienst
bei jedem Einschalten automatisch gestartet wird.
Durch die Aktivierung des Flags ,DAILY RESTART AT HOURS
(0..23)" wird eine Tageszeit festgelegt, zu der der Dienst
automatisch neu gestartet wird.
Mit der Schaltflache ,VNC STARTEN” wird der Dienst
manuell gestartet.
Die Schaltflache ,KILL VNC” beendet den Dienst manuell.
Die Schaltflache ,START CONFIG" 6ffnet das VNC-Kon-
figurationsfenster, um das Authentifizierungssystem
einzustellen, das Zugangspasswort zu dndern usw.
Achtung: Das Andern der Parameter wird fortgeschrittenen Benutzern empfohlen, da eine un-
sachgemiBe Anderung der Parameter zu einer Fehlfunktion des Remote-Desktop-Dienstes fiihren
kann.
Der Zugriff auf den VNC-Server erfolgt iber Port 5900 und ist standardmaBig anonym.

2.h VPN

Von diesem Fenster aus konnen Sie auf die Konfiguration-
soberflache des PixsysPortal VPN-Dienstes zugreifen und
ihn starten oder manuell beenden.
Wenn Sie die Option “RUN VPN at STARTUP” aktivieren, wird
das Bedienfeld so konfiguriert, dass der PixsysPortal-Dienst
bei jedem Einschalten automatisch gestartet wird.
Mit “VPN starten” wird der Dienst manuell gestartet (wenn
er nicht bereits gestartet ist), mit “VPN beenden” wird der
Dienst manuell beendet (wenn er lauft).
Weitere Informationen lber die Konfiguration und die Anforderungen des Dienstes finden Sie in
der Dokumentation, die auf der entsprechenden Seite unserer Website https://www.pixsys.net/
convertitori-gateway/gateway-vpn/pixsys-portal verfligbar ist.

2. MQTT
In diesem Fenster kdnnen die in den Bediengerdten mit
integrierter SoftPLC verfligbaren MQTT-Funktionen konfi-
guriert werden. Der Dienst ist ein “ModbusTCP-Master -->
MQTT-Client”, der Daten aus den LogicLab-Statusvariablen
abruft und sie als MQTT-Client an den eingerichteten
Server verdffentlicht.
Durch Aktivieren des Flags “Enable MQTT CLIENT” wird der
Dienst beim Start des Operator Panels aktiviert.
Im Feld “BROKER” muss die IP-Adresse des MQTT-Servers
eingetragen werden, auf dem das Panel die Themen
veroffentlichen wird (Port 443 lassen).
In den Feldern “USER” und “PASS” miissen die Anmeldedaten fiir die Verbindung zum MQTT-Server
eingegeben werden.
Das Feld “Client ID” konfiguriert die verdffentlichten Themen mit der folgenden Syntax “USER/Client
ID”, wobei %MAC als Client ID die MAC-Adresse des Bediengerits ist.
Durch Driicken von “SAVE” wird die vorgenommene Konfiguration Gbernommen.
Durch Driicken der Pfeiltaste gelangen Sie auf die zweite Seite, die im Folgenden beschrieben wird.
NB: Alle nicht beschriebenen Optionen befinden sich in der Entwicklungsphase und sind noch nicht
verfligbar.
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Das Feld “IP SERVER Modbus_TCP” muss mit der IP-Adresse
des ModbusTCP-Slave-Gerits ausgefiillt werden, das der
Dienst abfragen wird, um die zu veréffentlichenden Daten
abzurufen; die Angabe 127.0.01 bedeutet das Gerat selbst,
unabhangig von seiner Netzwerkkonfiguration (immer
Port 502 angeben).
Die Felder “n® INT16,INT32,FLO32 MB_TCP” geben an,
wie viele Register auf der ModbusTCP-Seite abgefragt
(und somit auf der MQTT-Seite veroffentlicht) werden,
beginnend mit dem angegebenen Feld “ADDR”.
Die “DSec”-Felder geben die Verdffentlichungszeiten der Themen an, ausgedriickt in Zehntel-
sekunden. Wird der Wert 0 beibehalten, erfolgt die Veréffentlichung nur bei einer Anderung der
Quelldaten.
Wenn Sie beispielsweise “n° INT16 MB_TCP” auf “2”, “ADDR"” auf “10010” und “DSec” auf “10” setzen,
werden die Register 10010 und 10011 vom ModbusTCP-Slave-Gerat abgefragt und jede Sekunde
veroffentlicht.
NB: Alle nicht beschriebenen Optionen befinden sich in der Entwicklung und sind noch nicht verfiigbar.
2j FTP
In diesem Fenster kdnnen die FTP- und TELNET-Funktionen
des Geréts konfiguriert werden.
Die Felder “FTP Aktiviert” und “TELNET Aktiviert” aktivieren
den integrierten FTP-Server bzw. TELNET-Dienst.
Die Felder “Anonymer Zugang” erméglichen den anonymen
Zugang flr den jeweiligen Dienst. Ist eines der beiden
angezeigten Hakchen deaktiviert, ist der Zugriff auf den
jeweiligen Dienst mit den in den unteren Feldern einge-
stellten Anmeldedaten méglich (maximal 2 Benutzer).
NB: Standardmagig sind beide Dienste aktiv und erfordern keine Zugangsdaten (@anonymer
Zugang).

2.k BACKUP-RESTORE
BACKUP: Verfahren zum Sichern (Upload von HMI) von LogicLab- und Movicon-Projekten.

Nach dem Download der LogicLab- und Movicon-Projekte
auf das Gerédt sowie nach der Konfiguration des Geréts zur
Projektausfiihrung bei jedem Start muss das Gerat aus-
und wieder eingeschaltet werden, indem das Stopp-Sym-
bol gedriickt gehalten wird.

Dies startet das Fenster des TDControlPanel.
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Stecken Sie nun einen USB-Stick, formatiert auf FAT32, in
einen der verfligbaren USB-Anschlisse.

Driicken Sie ,BACKUP-RESTORE", um auf das Dienstpro-
gramm zuzugreifen, das die Projekte und die Geratekonfi-
guration sichert.

In diesem Fenster kann gewdhlt werden, welche Ressourcen gesichert werden sollen:

PLC_LOGICLAB (RUNTIME-PROJECT): Sichert das LogicLab-Projekt (und die gesamte Runtime)
sowie die im Fenster ,PLC_LOGICLAB" (erreichbar liber das Hauptfenster des TDControlPanel)
vorgenommene Konfiguration.

HMI_MOVICON(PROJECT): Sichert nur das Movicon-Projekt sowie die im Fenster ,HMI_MOVICON"
vorgenommene Konfiguration (zuganglich Giber das Hauptfenster des TDControlPanel).
HMI_MOVICON (RUNTIME): Sichert nur die Runtime.

TdControlPanel (Konfiguration): Sichert die gesamte Konfiguration, die in den verschiedenen
Dienstprogrammen vorgenommen wurde, die Uber das Hauptfenster des TdControlPanel
zuganglich sind. Hinweis: Auf diese Weise wird auch ein eventuelles Zugangspasswort zum TdCon-
trolPanel gesichert, falls es im Fenster ,WIN EXPLORER" eingerichtet wurde.

LAN (IP CONFIGURATION): Sichert die Netzwerkkonfiguration des Gerits.

BOOT SCREEN: Sichert das Hintergrundbild, das beim Systemstart angezeigt wird.

Beim Aktivieren aller Kastchen werden die Konfiguration sowie die im Gerat enthaltenen Software-
programme vollstdndig gesichert. Dies beschleunigt auch die Programmierung mehrerer Bedien-
terminals.

Durch Driicken der Taste ,BACKUP TO USB DISK” wird der
an das Terminal angeschlossene USB-Speicher gedffnet. Es
kénnen ein Zielordner und der Namen der Sicherungsdatei
ausgewahlt werden (der Standarddateiname ist das Datum
und die Uhrzeit der Erstellung der Datei).

Durch Driicken auf ,OK” startet der Sicherungsvorgang (in
der Mitte des Bildschirms wird eine Sanduhr angezeigt).
Ein Bestatigungs-Popup zeigt das Ende des Vorgangs

an. Durch Driicken von ,OK" wird das Popup-Fenster
geschlossen. Durch Driicken von ,ESC” kann das Gerat
ausgeschaltet werden.

42 - HMI Series - Benutzerhandbuch



RESTORE: Verfahren zum Wiederherstellen (Upload auf HMI) von LogicLab- und Movicon-Projekten.

Um ein neues Gerat aus einer Sicherungskopie heraus zu
programmieren, driicken und halten Sie beim Einschalten
das Stopp-Symbol.

Dies startet das Fenster des TDControlPanel.

Stecken Sie nun einen USB-Stick mit der Sicherungskopie in
einen der verfligbaren USB-Anschlisse.

Driicken Sie ,BACKUP-RESTORE”, um auf das Dienstpro-
gramm zuzugreifen, das die Projekte und die Geratekonfig-
uration sichert.

Durch Driicken der Taste ,RESTORE FROM USB DISK”
wird der an das Terminal angeschlossene USB-Speicher
gedffnet, und die zuvor erstellte Sicherungsdatei kann
ausgewadhlt werden.

Durch Driicken auf ,OK" startet der Wiederherstellung-
svorgang (in der Mitte des Bildschirms wird eine Sanduhr
angezeigt).

Ein Bestdtigungs-Popup zeigt das Ende des Vorgangs

an. Durch Driicken von ,,OK” wird das Popup-Fenster
geschlossen. Durch Driicken von ,ESC” kann das Gerat
ausgeschaltet werden.

Von nun an startet das Gerat bei jedem Einschalten automatisch Projekte (und die gesamte
Konfiguration, falls in der Backup-Phase ausgewahlt).

3 LogicLab-Suite (nur HMI+SoftPLC)

LogicLab-Suite ist die Entwicklungsumgebung von Pixsys fiir die Programmierung der SPS PL500 und
der gesamten Serie der Bedienterminals und PanelPCs.
Die Suite kann nach der Registrierung im Downloadbereich von pixsys.net heruntergeladen werden.
Sie erfordert keinen Aktivierungscode. Sie ist kompatibel mit allen Versionen von Windows 32/64bit
ab Windows XP SP3 und ist in englischer und italienischer Sprache verfligbar. Nach dem Download
der Setup-Datei auf den eigenen Computer kdnnen die Installation gestartet und das Standardver-
fahren befolgt werden. Nach der Installation wird das Programm Uber das Symbol ,LogicLab” & auf
dem Desktop oder tiber das Menu ,Start” > ,PixsysSuite” > ,LogicLab" gestartet.
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3.a

3.b

Andern der Sprache

Erstellen - Laden eines Projekts

Die Anzeigesprache kann im Optionsfenster Giber
das Menu ,File” > ,Options” gedndert werden. In
der Registerkarte ,Language” kann die italienische
Sprache ,ITA - italiano” markiert und mit ,Select”
gewahlt werden. Bestatigen Sie anschlieend

mit ,OK" und schlieen Sie LogicLab, um die
Anderungen zu iibernehmen.

Offnen eines bestehenden Projekts:

+ Klicken Sie bei gedffnetem LogicLab auf die
Schaltflache ,Open project” oder wéhlen Sie
eines der zuletzt ge6ffneten Projekte aus der
Liste der zuletzt ge6ffneten Projekte aus.

« Ist LogicLab geschlossen, kénnen Sie
im Projektordner auf die Datei mit dem
gewdlinschten Projektnamen mit dem Symbol
@ und der Erweiterung ,.plcprj” doppelklicken.

Erstellen eines neuen Projektes:

Driicken Sie die Schaltflache ,New project”.
Geben Sie in dem daraufhin angezeigten Fenster
einen Namen fiir das Projekt ein und bestimmen
Sie den Ordner, in dem die Projektdateien
gespeichert werden sollen. Wahlen Sie schlie3lich
das Gerét aus, das Sie programmieren mochten.

YEN: Bei Aktivierung der Case-Sensitive-Option ,respect capital/lowercase letters” wird auf die
GroB- und Kleinschreibung im Variablennamen geachtet. Wir empfehlen daher, diese Option zu
deaktivieren, um Verwirrung beim Schreiben von Programmcode zu vermeiden.

3.c

Verbinden mit Zielgerat

Die Voraussetzungen fiir die korrekte Verbindung zwischen dem Zielgerdt (dem zu programmieren-
den Gerét) und der PC-Entwicklungsumgebung (LogicLab) sind Folgende.
Anforderungen an das Zielgerat:

Gerat wurde eingeschaltet und gestartet.

Gerat ist konfiguriert mit einer statischen IP-Adresse, die mit dem Netz und dem zu verbindenden
PC kompatibel ist. Standardmafig ist die IP-Adresse der HMI-Terminals 192.168.0.100 und jene
des PL500 192.168.0.99. Der Entwicklungs-PC muss dasselbe Netzwerk und dieselbe Klasse haben
(in diesem Fall 192.168.0.XXX), aber eine andere physische Adresse (d. h. die letzten drei Ziffern
der IP-Adresse, mit einer beliebigen Zahl zwischen 1 und 255, au3er 100). Sollte es erforderlich
sein, die IP-Adresse des Terminals gegeniiber der Standardadresse zu @ndern, lesen Sie bitte die
Beschreibung der Konfiguration des TDControlPanel, Abschnitt ,LAN ETH1* par. 2.d.

Direkte Verbindung zwischen PC und Netzwerkkabel (direkt oder gekreuzt) oder tiber einen Netz-
werk-Switch.
SoftPLC befindet sich in Ausfiihrung (siehe Beschreibung der Konfiguration des TDControlPanel,
Abschnitt ,PLC LOGICLAB, par. 2.c).
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Anforderungen an den Entwicklungs-PC:

« IP-Adresse muss mit dem bestehenden Netz, in dem es sich befindet, und mit der im Zielgerat
konfigurierten IP-Adresse kompatibel sein (siehe vorherige Punkte).

+ Antivirus/Firewall lassen eine Verbindung zu Gerdten im Netzwerk zu (sind in der Regel bereits
korrekt konfiguriert).

+ LogicLab ist so konfiguriert, dass es sich mit dem angeschlossenen Zielgerdt verbindet, das
programmiert werden soll: Im Menii ,On Line” > ,Select communication” wahlen, im Fenster auf
die Schaltflache ,Properties” driicken, unter ,IP Address” die IP-Adresse des Zielgerats eingeben
und alle anderen Einstellungen unverandert lassen. In sehr langsamen Netzen oder bei einer Netz-
konfiguration mit mehreren Switches kann der Timeout-Wert (in mS) erhéht werden.

Die Abbildung zeigt die Standardkonfiguration.

Bestatigen Sie alle Fenster mit ,OK” und speichern Sie iber das Symbol  oder iiber das Menu ,File”
> ,SaveProject”.

Um zu lberpriifen, ob die Konfiguration von LogicLab und dem Zielgerdt korrekt ist, kann die
Verbindung tber das Symbol T oder tiber das Meni ,On Line” > ,Connect” hergestellt werden. Ist
die Verbindung erfolgreich, zeigt die Statusleiste in der rechten unteren Ecke ,CONNECTED” und ,NO
CODE" an (Zielgerat verbunden, kein Code vorhanden) oder ,DIFF CODE” (Code nicht Gibereinstimm-
end mit dem Zielgerate-Code).

3d Kompilieren und Downloaden des Codes

Nach der Eingabe des Projektcodes muss dieser kompiliert werden, um ihn auf Fehler zu tiberprifen.
Dies kann mit der Taste F7, Uber das Symbol & oder tiber das Menu ,Project” > ,Fill" erfolgen.

War die Kompilierung erfolgreich, kann das Programm durch Driicken von F5, iber das Symbol
oder Uber das Meni ,On Line" > ,Code transferring” auf das Zielgerat Gibertragen werden.

In der Statusleiste wird nun ,CONNECTED" und ,SOURCE OK" angezeigt. Das bedeutet, dass das auf
dem Zielgerat laufende Programm mit dem auf dem PC angezeigten Programm libereinstimmt.

3.e Watch Window

Wenndasim Zielgeratlaufende Programm mitdem auf dem PCangezeigten Programm tbereinstimmt,
werden in der Statusleiste ,CONNECTED" und ,SOURCE OK" angezeigt. Uber das ,Watch Window"
kann der Status der im Projekt verwendeten Variablen in Echtzeit Gberprift werden. Um das ,Watch
Window" zu aktivieren, drlicken Sie STRG+T oder verwenden Sie das Menu ,View" > ,View tool window"
> ,Watch”. Um eine Variable zum ,Watch Window" hinzuzufligen, ziehen Sie sie einfach hinein oder
driicken Sie auf das Symbol  und wahlen Sie sie manuell aus.

Von nun an zeigt das Watch Window den Wert
der eingegebenen Variable in Echtzeit an.

Uber die entsprechenden Schaltflichen ist es auch méglich, eine bestehende Watch-Liste zu
speichern, zu laden und hinzuzufiigen.
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Wenn das Anzeigeformat gedndert werden soll, wahlen
Sie einfach die Variable aus und drticken Sie das Symbol
.Wahlen Sie in dem nun erscheinenden Fenster das
gewlinschte Format aus und bestétigen Sie mit ,OK".

4 Verbinden von Movicon 11 und LogicLab (nur
HMI+SoftPLC)

Anmerkung: Movicon 11.5 oder héher erforderlich.

Nur beim ersten Mal durchzufiihren:

Laden Sie auf dem PC, auf dem Sie entwickeln, im Download-Bereich der Pixsys-Website in der Sektion
Movicon die Datei ,MOVICON 11.6 Update-Aggiorna Driver.exe” herunter, welche der Architektur
des verwendeten PCs entspricht. Starten Sie die Datei mit einem Doppelklick und folgen Sie den
Anweisungen auf dem Bildschirm.

Wird ein Panel-PC (TD750-TD850-TD900-TD910-TD920) verwendet, muss dies auch auf dem Panel-PC
erfolgen. Pramisse: Mit diesem Verfahren werden alle SPS-Systemvariablen und alle im SPS-Projekt
erstellten und verwendeten Variablen importiert.

Die Erstellung und Aktualisierung der SPS-Variablenliste erfolgt nur, wenn das LogicLab-Pro-
gramm fehlerfrei kompiliert und auf das Zielgerat geladen wurde.

4.a Erstellen eines neuen Movicon-Projektes

Starten Sie die Software und wahlen Sie die Plattform ,Windows® X86 / X64" fur Panel-PCs und
Windows® CE” fur HMIs und die PL500-Version ,WEB". Wenn ein neues Movicon-Projekt mit Hilfe des
Assistenten erstellt wird, erscheint am Ende das Treiberkonfigurationsfenster, weshalb direkt zum
Abschnitt , Treiberkonfiguration®, par. 4.b ibergegangen werden kann. Wenn Sie den Treiber manuell
installieren, folgen Sie hingegen den nachsten Schritten.

Fligen Sie den Kommunikationstreiber hinzu,
indem Sie mit der rechten Maustaste auf ,Real
time DB" und dann auf ,New communication
driver” klicken.

Wahlen Sie ,Pixsys” aus dem Herstellermeni
und dann ,,Pixsys SoftPLC Driver".

Bestdtigen Sie mit ,OK"” und doppelklicken
Sie auf den neu erstellten Treiber, um das
Konfigurationsfenster zu 6ffnen.
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4.b Konfigurieren des Treibers

Wahlen Sie die Registerkarte ,Station” und
fligen Sie mit der Schaltflaiche ,ADD" eine neue
Station hinzu.

1. Geben Sie den Pfad zur SPS-Symboldatei ein,
die sich im Unterordner ,Build” des Ordners
befindet, der die LogicLab-Projektdateien
enthélt. Die Datei hat die Erweiterung
SYMXML und ermdglicht es |hnen, die
SPS-Variablen in das Movicon-Projekt zu
importieren.

4.

. Dieses Feld wird nach der Eingabe des Pfades in Schritt 1 automatisch kompiliert: Bei Verwendung

von HMIs und PL500 darf das automatisch kompilierte Feld nicht verandert werden. Bei Panel-PCs
(TD750-TD850- TD900 etc.) geben Sie den Pfad an, in dem das LogicLab-Projekt heruntergeladen
wurde (standardmaBig D:\LLExec\ NameMyProjectLogicLab.sym.xml).

. Wird die Movicon-Anwendung auf dem Panel-HMi oder dem Panel-PC ausgefihrt, auf dem sich

auch SoftSPS befindet, geben Sie die IP-Adresse 127.0.0.1 ein. Wird Movicon hingegen auf einem
anderen Panel-HMi oder Panel-PC als jenem von SoftPLC betrieben, muss die IP-Adresse von
SoftPLC angegeben werden. Damit kdnnen Sie auch das Movicon-Projekt auf Ihrem Entwicklungs-
PC im Vorschaumodus ausfilhren und die Kommunikation mit der SoftPLC tberpriifen. Fir diese
Funktion ist es notwendig, die IP-Adresse des zu programmierenden Terminals anzugeben (erst
am Ende der Entwicklung sollten Sie die localhost-Adresse 127.0.0.1 eingeben, damit die im Panel
befindliche Movicon-Laufzeit mit der auf demselben Rechner laufenden SoftPLC kommunizieren
kann).

Geben Sie in unter ,General” einen Namen fir die Station, z. B. ,PLC".

Driicken Sie OK, um die Einstellungen zu speichern und den Vorgang zu beenden.

Nun kénnen die Variablen des LogicLab-Pro-
jektin Movicon importiert werden.

Klicken Sie mit der rechten Maustaste auf
,Pixsys SoftPLC" und wahlen Sie ,,/mport PLC
database”.
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Klicken Sie auf die Schaltflache ,Read from PLC
project”; die Liste der verfiigbaren Variablen
wird angezeigt.

Wahlen Sie dann die Variablen aus, die Sie
importieren méchten. Klicken Sie auf die
Schaltflache ,import”.

Anmerkung: Beim Importieren einer Array-Variable wird diese als Struktur mit dem Namen des
Arrays angezeigt. Auf die Array-Elemente kann einzeln mit der Syntax NameMyArray:NameMyArray_X
zugegriffen werden. X ist der Index des Arrays (beginnend bei 0). Die Variablen sind jetzt im Movicon-
Projekt verfiigbar. Sollen neue Variablen importiert werden, z.B. nach einer Anderung des LogicLab-
Projektes, wiederholen Sie einfach das Verfahren zum Lesen und Importieren der Variablen.

4.c Ubertragen von Movicon-Code in das Zielgerit
Das Ubertragen des Movicon-Projekts erfolgt mit dem Symbol:

1. Wihlen Sie das Ubertragungsprotokoll: TCP.

2. Geben Sie die IP-Adresse des Zielgerdts ein
(Standard fir HMI/SPS: 192.168.0.100).

3. Lassen Sie bei Verwendung von HMI/SPS das
Feld leer, geben Sie bei Panel-PCs ,user” ein
(oder den Namen des im Zielgerat-Panel-PCs
angemeldeten Benutzers).

4. Lassen Sie bei Verwendung von HMI/SPS das
Feld leer, geben Sie bei Verwendung eines
Panel-PCs 123456 ein.

5. Geben Sie bei Verwendung von HMI/SPS \
NandFlash\MyMoviconProjectName\ ein, geben
Sie im Falle eines Panel-PCs D:\MyMoviconPro-
jectName\ ein. Movicon erstellt einen Ordner mit
dem Namen MyMoviconProjectName und ladt
alle Projektdateien in diesen Ordner herunter.

6. Driicken Sie auf die Schaltflache ,Upload Project”,
um die Ubertragung zu starten (driicken Sie auf
JYes to All”, falls Sie bereits ein Projekt herunter-
geladen haben und es iberschreiben méchten).

7. Nach Beendung des Downloadvorganges
klicken Sie auf ,Start Device Project”, um das
Projekt auf dem Zielgerat auszufiihren (das
laufende Projekt wird beendet und das zuletzt
Ubertragene Projekt wird gestartet).

Anmerkung: Wenn mehrere verschiedene Projekte/Versionen tibertragen werden sollen, @ndern Sie
einfach den Zielordner (der erste Teil \NandFlash\ muss jedoch beibehalten werden). Im TdControlPa-
nel muss ausgewahlt werden, welches Projekt aus dem Geratspeicher beim Einschalten des ZielGerats
automatisch gestartet werden soll (siehe Abs. 70.b).

Anmerkung2: Mit der Schaltfliche ,Geréatespeicherkarte l6schen” koénnen Sie den im Feld
.Gerdteordner” angegebenen Ordner I6schen, wodurch die darin enthaltenen Projektdateien aus dem
Panel entfernt werden. Wenn unter \NandFlash\ kein Ordner angegeben ist, |6scht diese Schaltflache
alle Dateien, die sich auf \Nandflash selbst befinden, wodurch das Panel unbrauchbar wird!
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5 Simulieren des gesamten SoftPLC-SCADA-Projekts (nur
HMI+SoftPLC)

Starten Sie den Simulatorin LogicLab Giber das Symbol = oder Gberdas Meni ,Debug” > ,Simulation
mode”. Erstellen Sie im visualisierten Fenster einen neuen Arbeitsbereich und geben Sie den Namen
und Zielordner an (standardmaBig ist der Ordner ausgewahlt, in dem sich das Projekt befindet).

Der Simulator wird gestartet und verbunden (das Statusfenster zeigt den Status ,CONNECTED" an),
aber ohne Code (das Statusfenster zeigt den Status ,NO CODE” an). Ubertragen Sie den Code durch
Driicken der Taste F5, Giber das Symbol  oder Uber das Menii ,Online” > ,Online download code”.
Vergewissern Sie sich, dass in der Statusleiste ,CONNECTED" und ,SOURCE OK" angezeigt werden. Wird
immer noch ,NO CODE" angezeigt, starten Sie den Simulator neu (iber das Symbol # oder Meni
,Online" > ,Target reboot").

Rufen Sie in Movicon das Konfigurationsfenster des Pixsys-Treibers auf und konfigurieren Sie es wie
folgt:

1. Geben Sieden Ordneran, in dem sich das
LogicLab-Projekt befindet (unterordner
,Build”); wdhlen Sie die Datei NameMy-
ProjectLogicLab.sym.xml.

2. Geben Sie den Ordner ein, in dem der
Simulator arbeitet, setzen Sie den Datei-
typfilter auf ,All files (**)" und wahlen Sie
die Datei NameMpyProjectLogicLab.sym.
simul. Achten Sie auf die Dateierweite-
rung, da im Projektordner viele Dateien
mit demselben Namen, aber unter-
schiedlichen Erweiterungen existieren.

3. Legen Sie die Localhost-Adresse fest:
127.0.0.1.

4. Geben Sie unter ,General” einen Namen
fur die Station ein, z. B. ,SPS".

Um die Simulation der grafischen Benutzeroberflache zu starten, die mit dem Simulator verbunden

ist (der bereits den zuvor heruntergeladenen Code ausfiihrt), driicken Sie Alt+F12, das Symbol  oder

das Menu ,File" > ,Start Project”. Um die Simulation zu beenden, driicken Sie Alt+F12 oder das Symbol
in der oberen Leiste.
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Beschrankte Haftung

Pixsys S.r.l. garantiert seine elektronischen Geréte fiir einen Zeitraum von 12 Monaten ab Rechnungs-
datum. Die Herstellergarantie ist begrenzt auf die Reparatur oder den Ersatz von Teilen mit Fabri-
kationsfehlern, die unter Angabe der Riicksendenummer (internes RMA-Autorisierungsverfahren)
an unser Haus zuriickgesandt werden. Pixsys haftet nicht fur Unfdlle/Schadensfélle und Personen-
oder Sachschaden, die infolge von Manipulation (einschlie8lich Reparaturversuchen durch nicht
autorisiertes Personal) oder aufgrund von ungeeigneten Umgebungsbedingungen, unsachgemaBer
Installation oder durch falschen, unsachgemafBen oder jedenfalls durch einen nicht mit den in der
technischen Dokumentation angegebenen Eigenschaften des Geréts konformen Gebrauch entstehen.
Unter keinen Umstédnden geht die Haftung des Herstellers tiber den Wert des Geréts hinaus. Die
Garantie deckt in keiner Weise Probleme ab, die sich aus der Installation von Softwareprogrammen
nach dem Verkauf ergeben, und insbesondere keine Schaden, die durch die Ausfiihrung von Malware
entstehen. Fir jede Supportleistung von Pixsys zur Wiederherstellung des Betriebssystems oder der
Programme wird die geltende Supportgebihr verrechnet.

Anmerkungen / Updates
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Read carefully the safety guidelines and programming instructions contained in this manual
before using/connecting the device.

Prima di utilizzare il dispositivo leggere con attenzione le informazioni di sicurezza e settaggio
contenute in questo manuale.

Vor Verwendung des Gerétes sind die hier enthaltenen Informationen beziiglich Sicherheit und
Einstellung aufmerksam zu lesen.

c RoHS 07 l% E

Compliant %% —

PIXSYS s.r.l.

WWW.pixsys.net
sales@pixsys.net - support@pixsys.net

online assistance: http://forum.pixsys.net

via Po, 16 1-30030
Mellaredo di Pianiga, VENEZIA (IT)
Tel +39 0415190518
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